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Overview

A ZigBee sniffer allows capture and display of data frames transmitted between ZigBee devices. It
captures the data received with a separate radio from that used by the main system, and can display
low level frames that can be useful for debugging problems on the network. Often these low level
issues can not be otherwise debugged using higher level APIs that connect to the coordinator as this
information is simply not provided.

This document provides information on setting up and using the Wireshark software. Different
hardware is available for use with this including the Texas Instruments CC2531 dongle that is
commonly available at low cost in online marketplaces such as eBay and AliExpress, and the CEL
MeshConnect dongle, or other dongles using the Silabs Ember chipset can also be used.

There are many resources available for using Wireshark, and this document does not intend to replace
a good understanding of the software or protocol analyses principals. It does however provide the
user with a basic understanding of ZigBee and Wireshark a quick start guide to packet sniffing for the
purposes of providing feedback to Z-Smart Systems when reporting ZigBee issues.

Wireshark

Wireshark is a packet capture and analyses tool that can be downloaded freely from the web. It is
capable of displaying the contents of ZigBee packets, and allows the debugging of low level protocol
issues. Wireshark can be downloaded from https://www.wireshark.org/.
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Download Wireshark

The current stable release of Wireshark is 2.6.2.

Stable Release (2.6.2) « July 18,2018

Windows Installer (64-bit)

Windows Installer (32-bit)

Windows PortableApps® (32-bit)
macO0S 10.6 and later Intel 64-bit .dmg
Source Code

Old Stable Release (2.4.8) « July 18,2018

Development Release (2.5.1) « March 15,2018

Documentation

More downloads and documentation can be found on the downloads page.

Dongle Specific Sniffers

Wireshark does not directly interact with ZigBee hardware - it requires a dongle and associated sniffer
software to provide it with the data to analyse. The sniffer is very simple - it is only grabbing the low
level frames from the dongle and passing them to Wireshark. Note that when used as a sniffer, the
dongle is not running in its standard mode and is not used as a node on a ZigBee network. It will
normally either run different firmware, or be configured into a specific mode to provide the low level
data required.
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Texas CC2531

Sniffer software in Python is available here -:
https://github.com/andrewdodd/ccsniffpiper

To install on a Mac OS X -:

brew install libusb

easy_install pip

pip install pyusb

Note that | haven’t tried this software and it may create named pipes that mean Wireshark is started
slightly differently than described below.

TB8D...

Ember NCP Sniffer

The Z-Smart Systems Ember sniffer software is written in Java so can be run on any computer with a
Java VM. It can be used with most standard Ember NCP firmware (any containing the mfglib library),
and when running will place the dongle into a special mode where low level frames are provided as
required for the sniffer application.

The sniffer application can directly write the Wireshark pcap files and Silabs ISD files.
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CBL MeshConnect™

USB Stick +)

The sniffer is available on Github

https://github.com/zsmartsystems/com.zsmartsystems.zigbee.sniffer

The sniffer is a console application and requires configuring through the command line -:

usage: ZigBeeSniffer

-?,—help Print usage information

—-a,——ipaddr <remote IP address> Set the remote IP address

-b,--baud <baud> Set the port baud rate

—-c,——channel <channel id> Set the ZigBee channel ID

-f,—flow <type> Set the flow control (none | hardware |
software)

-1,—1local Log times in local time

-m,——maxpcap <length> Maximum filesize for Wireshark files

—-p,——port <port name> Set the port

-r,——ipport <remote IP port> Set the remote IP port

-s,——silabs <filename> Log data to a Silabs ISD compatible
event log

-t,——timeout <seconds> NCP restart timeout in seconds

-w,——pcap <filename> Log data to a Wireshark pcap compatible
log

Note that the IP address will default to the local host on the assumption that you are running
Wireshark on the same computer as the sniffer. The ipport will default to 17754 which is the port
used for the ZigBee Encapsulation Protocol - changing this may stop Wireshark displaying ZigBee
data.

Example command line -:
java —jar ZigBeeSniffer.jar —-port /dev/tty.SLAB_USBtoUART —-baud 115200 -flow hardware

The software will print an output to the console for each packet that is received to allow confirmation it
is working. When running Wireshark, these should also be seen in the Wireshark window.

WiresharkZepFrame [sequence=00000000, 1qi=255, data={41 88 41 EF CD FF FF 00 00 09 12 FC FF 00 00 01 81 01 00 00 00 00 08 22 00 28 00 10 01 00 01 00 00 00 00 08 22 00 00 29 B8 AC EB 6B B7 FF 80}]
WiresharkZepFrame [sequence=00000001, 1qi=255, data={41 88 42 EF CD FF FF 00 00 09 12 FC FF 00 00 01 82 01 00 00 00 00 08 22 00 28 01 10 01 00 01 00 00 00 00 08 22 00 00 B2 19 57 C0 98 DF FF 80}]
WiresharkZepFrame [sequence=00000002, 1qi=255, data={41 88 43 EF CD FF FF 00 00 09 12 FC FF 00 00 01 83 01 00 00 00 00 08 22 00 28 02 10 01 00 01 00 00 00 00 08 22 00 00 11 35 D3 Al 50 EO FF 80}]
WiresharkZepFrame [sequence=00000003, 1qi=255, data={41 88 44 EF CD FF FF 00 00 09 12 FC FF 00 00 01 84 01 00 00 00 00 08 22 00 28 03 10 01 00 01 00 00 00 00 08 22 00 00 26 82 40 4F 7C 8E FF 80}]

If the NCP fails to receive a valid frame with the timeout period set with the -t command line
parameter, then the NCP will be restarted. This will allow the sniffer to recover from serial port or NCP
communications problems. The timer defaults to 30 seconds.
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Software Operation

Configuration

A few options that may be worth considering to make the software more usable -:

Time format - setting to time of day may help to coordinate different log files, such as the log
generated by the Z-Smart Systems ZigBee framework. By default, the time will be in microseconds -
milliseconds is probably sufficient.

Date and Time of Day (1970-01-01 01:02:03.123456) 381
Year, Day of Year, and Time of Day (1970/001 01:02:03.123456)

v Time of Day (01:02:03.123456) 382
Seconds Since 1970-01-01 83
Seconds Since Beginning of Capture X4
Seconds Since Previous Captured Packet X385
Seconds Since Previous Displayed Packet X 386
UTC Date and Time of Day (1970-01-01 01:02:03.123456) X387
UTC Year, Day of Year, and Time of Day (1970/001 01:02:03.123456)
UTC Time of Day (01:02:03.123456) X8

Automatic (from capture file)
Seconds
Tenths of a second
Hundredths of a second

v Milliseconds
Microseconds
Nanoseconds

Display Seconds With Hours and Minutes

Getting Started

From the Wireshark start screen, you need to start receiving the ZEP (ZigBee Encapsulation Protocol)
frames that are sent to port 17754. The filter udp port 17754 will ensure that only ZigBee frames are
captured. If you are running the sniffer on the same computer as Wireshark, then you will probably
want to use the Loopback interface - otherwise select another suitable interface.

Capture

...using this filter: [ \ udp port 17754 v] All interfaces shown v

Loopback: 100 [
gif0
stf0
XHC20
@ Cisco remote capture: ciscodump
@ Random packet generator: randpkt

Learn

User's Guide - Wiki - Questions and Answers - Mailing Lists

You are running Wireshark 2.6.2 (v2.6.2-0-g1b3cedbc).

Once Wireshark starts to capture packets, they will be displayed in the main screen as seen below.
This is broken into 3 main areas - the list of received packets, the detailed packet information, and the
raw packet data.
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[ BON ] ) ZigBee Capture.pcapng
7 : _
@ W-EGR P Qe==3F 85 Q Q &
(W[ Apply a display filter ... <38/> ~| Expression... + Leave
No. Time Source Destination Protocol Length Info
219 17:31:58.613532495  0x0000 0x2845 ZigBee 121 APS: Ack, Dst Endpt: @, Src Endpt: @
221 17:31:58.661335604  @x1f75 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Addr: 7c:25:24:00:00:16:37:62
222 17:31:58.696167177 ox1f75 0x0000 ZigBee HA 126 ZCL: Report Attributes, Seq: @
224 158.696585689 0x3a67 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Addr: 7c:25:24:00:00:16:6c:fc
ZCL: Report Attributes, Se
226 44050504  0xb465 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Ad uirky_00:00:07:39:01
227 131:58.744704715 ox1f75 0x0000 ZigBee HA 126 ZCL: Report Attributes, Seq: 1
229 17:31:58.745939209 0xb465 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Addr: Quirky_00:00:0’
230 1 .769788824  @x5d72 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Adi
231 17: .770204216 0x3a67 Broadcast ZigBee ZDP 131 Device Announcement, Nwk Addr:
232 158.986207483 0x0000 0xd545 ZigBee ZDP 121 Link Quality Request
234 17:31:58.987056728 0x0000 0xd545 ZigBee ZDP 121 Link Quality Request

Destination PAN: @x4dlc
Destination: @x0000
Source: 0x1f75
[Exte Source: 7c:25:24:00:00:16:37:62 (7c:25:24:00:00:16:37:62)]
Orig. 141
» Frame Check Sequence (TI CC24xx format): FCS OK
» ZigBee Network Layer Data, Dst: 0x0000, Src: 0x1f75
v ZigBee Application Support Layer Data, Dst Endpt: 1, Src Endpt: 1
v Frame Control Field: Data (@x00)
...... 00 = Frame Type: Data (@x0)
elivery Mode: Unicast (0x@)
ecurity: False
cknowledgement Request: False
Extended Header: False
Destination Endpoint: 1
Cluster: On/0ff (0x@006)
Profile: Home Automation (0x0104)
Source Endpoint: 1
Counter: 3
» ZigBee Cluster Library Frame, Command: Report Attributes, Seq: 1
0000 00 00 00 00 00 00 00 00 00 00 00 00 08 00 45 00 T
0010 00 70 41 45 40 00 40 11 fb 35 7f 00 00 01 7f 00 PAE( 5

Q@
0020 00 01 45 5a 45 5a 00 5c fe 6f 45 58 02 01 19 00 “EZEZ-\ -OEX
0030 01 @0 ff df 2a bl 7e be 35 3f 7c 0@ 00 79 dc 00 -

Setting Security Keys

To properly decode ZigBee frames, the keys must be added to Wireshark preferences. If Wireshark
doesn’t know your keys, it will not display the full packet contents and will effectively be useless for
analysing data.

At least the network key is required. Select the preferences, and go to the ZigBee Protocol
preferences page. Select the Edit button to change the Pre-configured Keys.

[ NON ) £ Wireshark - Preferences

wrp ZigBee Net k L:
X.25 igBee Network Layer

XM Security Level = AES-128 Encryption, 32-bit Integrity Protection
X2AP

XDMCP
XMCP
XML
XMPP
XOT
XYPLEX
YAMI
YMSG
ZEBRA
ZigBee APS
ZigBee Green ...
ZIoP
ZRTP
ZNT

> Statistics

Advanced

Pre-configured Keys Edit...

Help Cancel m
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Enter your network key, and it is also advisable to enter the ZigBeeAlliance09 key that is normally
used to allow ZHA devices to join the network.

5A:69:67:42:65:65:41:6C:6C:69:61:6E:63:65:30:39

[ XON | 4 Pre-configured Keys
Key Byte Order Label
AA:AA:AA:AA:AA:AAAA:AAAA:AA:AA:AA:AA:AA:AA:AA Normal Test Key AA
B5A:69:67:42:65:65:41:6C:6C:69:61:6E:63:65:30:39 Normal ZigBeeAlliance09
+ - h A v E@ [Users/chris/.config/wireshark/zigbee pc_keys
Help Cancel ﬁ

Filters

Wireshark has a powerful filter system to allow frames to be selectively displayed. The Expression...
button in the filter bar will display the Filter Expression box.
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‘00 @ Wireshark - Display Filter Expression
Field Name Relation
» ZCL Shade Configuration - ZigBee ZCL Shade Configurati... | is present

» ZCL Sub-Ghz - ZigBee ZCL Sub-Ghz ==
» ZCL Temperature Meas. - ZigBee ZCL Temperature Meas. 1= . P el
. Relations can be used to restrict fields to specific
» ZCL Thermostat - ZigBee ZCL Thermostat > values. Each relation does the following:
» ZCL Thermostat User Interface Configuration - ZigBee Z... < is present Match any packet that
» ZCL Time - ZigBee ZCL Time >= . g""‘a'"s ‘ms ?_e'lj‘
P, . | =, etc. ompare the field to a
» ZCL Touchlfnk Zl_gBee ZCL Touchl{nk f- specific value.
» ZCL Tunneling - ZigBee ZCL Tunneling IN contains, matches Check the field against a
» ZEBRA - Zebra Protocol string (com(ainS) ?‘r a)regular
.7 . expression matches;
> Z!EP ZlgB.ee Encapsulation Protocol in Compare the field to a
v ZigBee - ZigBee Network Layer specific set of values

zbee_beacon.depth - Device Depth
zbee_beacon.end_dev - End Device Capacity
zbee_beacon.ext_panid - Extended PAN ID
zbee_beacon.protocol - Protocol ID 0x0
zbee_beacon.router - Router Capacity
zbee_beacon.tx_offset - Tx Offset

Value (Unsigned integer, 2 bytes)

Predefined Values

zbee_beacon.update_id - Update ID Network Specific
zbee_beacon.version - Protocol Version ZigBee Home
zbee_nwk.cmd.addr - Address ZigBee PRO

zbee_nwk.cmd.cinfo - Capability Information

zbee_nwk.cmd.cinfo.alloc - Allocate Short Address
zbee_nwk.cmd.cinfo.alt_coord - Alternate Coordinator

zbee_nwk.cmd.cinfo.ffd - Full-Function Device

zbee_nwk.cmd.cinfo.power - AC Power

zbee_nwk.cmd.cinfo.security - Security Capability

zbee_nwk.cmd.ed_config - End Device Configuration

zbee nwk.cmd.ed prnt info - Parent Information Range (offset:length)

Search:

zbee_beacon.profile == 0x0

Click OK to insert this filter

Help Cancel

Buttons can be configured to allow quick access to often used filters

[i \ zbee_beacon.profile == 0x2

~| Expression... +  Beacons

Filter Buttons Preferences... | Label: [Enter a description for the filter button Filter: zbee_beacon.profile == 0x2

Comment: Enter a comment for the filter button

Cancel OK

The following provides a useful set of filter buttons -:

# This file is automatically generated, DO NOT MODIFY.
Leave",'"zbee_nwk.cmd.id == 0x4","Filter all LEAVE commands"

Association","wpan.cmd == @x1 || wpan.cmd == 0x02","Filter ASSOCIATION related commands"

To add these to Wireshark, click the Filter Button Preferences... button above, then click on the link in
the bottom right corner of the following window to edit the file. Wireshark must be restarted before the

changes will be visible.
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[ NON ) M Wireshark - Preferences

v Appearance

Columns Show in toolbar Button Label Filter Expression Comment

Font and Colors Leave zbee_nwk.cmd.id == 0x4 Filter all LEAVE commands

Layout Association  wpan.cmd == 0x1 || wpan.cmd == 0x02 Filter ASSOCIATION related commands
Capture
Expert

Filter Buttons
Name Resolution
» Protocols
> Statistics
Advanced

+ - o A v E‘o [Users/chris/.config/wireshark/dfilter buttons

Help Cancel ﬁ

Colouring Rules

Wireshark can highlight packets in the packet window based on colouring rules. These use the same
rules as the filters and can be configured in the View menu, Colouring Rules... option.

[ NON ) M Wireshark - Coloring Rules Default
Name Filter
ZigBee Link Record zbee_nwk.cmd.id == 0x5
ZigBee Link State zbee_nwk.cmd.id == 0x8
ZigBee Link Response zbee_nwk.cmd.id == 0x2
ZigBee Link Request zbee_nwk.cmd.id == 0x1
ZigBee APS Ack zbee_aps.type == 0x2
ZigBee Announce Commands zbee_aps.zdp_cluster == 0x13
ZigBee Association Response wpan.cmd == 0x2
ZigBee Association Request wpan.cmd == 0x1
ZigBee Cluster Library Commands zbee_zcl

¥ ZigBee Leave Commands zbee_nwk.cmd.id == 0x4
v
ZigBee Beacon allowing joins zbee_beacon.router==true
ZigBee Beacon zbee_beacon.profile==0x2
ZigBee Beacon Request wpan.cmd == 0x7

ZigBee zep

Double click to edit. Drag to move. Rules are processed in order until a match is found.

+ - @

Help Import... Export... Cancel ﬁ
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The following provides a useful set of colouring rules that may be imported into Wireshark -:

# DO NOT EDIT THIS FILE! It was created by Wireshark

@ZigBee Link Record@zbee_nwk.cmd.id == 0x5@[65535,52428,26214][0,39321,13107]

@ZigBee Link State@zbee_nwk.cmd.id == 0x8@[65535,52428,26214][39321,39321,39321]
@ZigBee Link Response@zbee_nwk.cmd.id == 0x2@[65535,52428,26214][26214,0,0]

@ZigBee Link Request@zbee_nwk.cmd.id == 0x1@[65535,52428,26214][0,13107,39321]
@ZigBee APS Ack@zbee_aps.type == 0x2@[65535,65535,65535] [39321,39321,39321]

@IEEE 802.15.4 ACK@wpan.frame_type == 0x2@[65535,65535,65535] [52428,52428,52428]
@ZigBee Announce Commands@zbee_aps.zdp_cluster == 0x13@[26214,65535,26214] [65535,26214,26214]
@ZigBee Association Response@wpan.cmd == 0x2@[26214,65535,26214][26214,0,0]

@ZigBee Association Request@wpan.cmd == 0x1@[26214,65535,26214][0,13107,65535]
@ZigBee Cluster Library Commands@zbee_zcl@[26214,65535,65535]1[0,0,0]

@ZigBee Leave Commands@zbee_nwk.cmd.id == 0x4@[13107,13107,13107] [65535,39321,39321]
@ZigBee invalid beacon protocol@zbee_beacon.profile==0@[64764,0,7196][0,0,65535]
@ZigBee Beacon allowing joins@zbee_beacon.router==true@[52428,52428,52428][0,65535,0]
@ZigBee Beacon@zbee_beacon.profile==0x2@[52428,52428,52428] [65535,0,0]

@ZigBee Beacon Request@wpan.cmd == 0x7@[52428,52428,52428][0,0,65535]
l@ZigBee@zep@[59624,65535,41377]1[0,0,0]

Display Filter Macros

Display Filter Macros are a mechanism to create shortcuts for complex filters.

[ NON ) M Display Filter Macros

Name Text
zigbee_address zbee_nwk.src == $1 || zbee_nwk.dst == $1

+ - h A Vv E‘o [Users/chris/.config/wireshark/dfilter macros

Help Cancel ﬁ

For example defining a display filter macro named zigbee_address defined as zbee_nwk.src == $1 ||
zbee_nkw.dst == $1 could be used as ${zigbee_address:0x1234} to display all packets to or from
address 0x1234.

Macro ‘ Content

zigbee_address wpan.dst16 == $1 || wpan.src16 == $1
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Analysing Data

IO Graph

Wireshark provides a very useful facility to graph events. Any expression can be used to graph the
number of events per second.

[ NON ) Wireshark - |0 Graphs - wireshark.pcapng

Wireshark 10 Graphs: wireshark.pcapng

105 -
90
75 -
(s}
(]
(2]
< 60
12
©
X
S 45
o
30
15
o 1 1 1 Il L
0 30 60 90 120 150
Time (s)
Hover over the graph for details.
Enabled Graph Name Display Filter Color Style Y Axis Y Field SMA Period
7 All packets [ | Line Packets None
ZigBee Clust... zbee_zcl [ | Line Packets None
ZigBee Devi... zbee_zdp [ | Line Packets None
+ | = | @ Mouse @ drags zooms Interval 1 sec Time of day Log scale Reset
Help Copy Save As...
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Protocol Statistics

( ] o Wireshark - Protocol Hierarchy Statistics - test1 fireplace right 7c25240000163762.pcapng
Protocol v Percent Packets Packets Percent Bytes Bytes Bits/s End Packets
v Frame 100.0 3063 100.0 337806 54k 0
v Ethernet 100.0 3063 12.7 42882 6906 0
v Internet Protocol Version 4 100.0 3063 18.1 61260 9866 0
v User Datagram Protocol 100.0 3063 7.3 24504 3946 0
v ZigBee Encapsulation Protocol 100.0 3063 29.0 98016 15 k 0
v |EEE 802.15.4 Low-Rate Wireless PAN 100.0 3063 329 111144 17 k 994
v ZigBee Network Layer 59.5 1824 23.4 79105 12k 400
v ZigBee Application Support Layer 46.5 1424 6.5 21899 3527 502
ZigBee Device Profile 28.1 860 3.0 10093 1625 860
ZigBee Cluster Library 2.0 62 0.1 414 66 62
ZigBee Beacon 8.0 245 1.1 3675 591 245
No display filter.

Hep  Copy - [“Close |

Exporting Selected Packets

It may be necessary to export a select few packets to illustrate a problem you have identified. To do
this, you can select the packets, and export them as follows.

Mark packets using the Edit menu options -:
@& Wireshark File I:ﬁl View Go Capture Analyze Statistics Telephony Wireless Tools Help O N 1 D 3 D o 00%ED Sat11:12 Q=

@ o Copy > M Loopback: [00 (udp port 17754)
g Find Packet... 8F =
a4 = B, EF L= QQQE
= Find Next BN | =
W | Apply a display filter ... <¢  Find Previous 8B (=0 ~| Expression.. @ + Leave | Association = Announce
No. Time Sou Protocol Length Destination Info
ORI TN i . Mark/Unmark Packet #M ZigBee 111 0x0000 Rejoin Request, Device: 0x48f5
Mark All Displayed 0 8M
9620 22:54:08.927 @xd!  nmark All Displayed T ®M IEEE 802.15.4 76 0x0000 Data Request
9622 22:54:08.934 exol INext Mark T8N ZigBee 121 0x48f5 Rejoin Response, New Address: 0x48f5
Previous Mark 08B
9624 22:54:09.177 0xd4l IEEE 802.15.4 76 0x0000 Data Request
Ignore/Unignore Packet #8D
9626 22:54:09.429 0x4! IEEE 802.15.4 76 0x0000 Data Request
9628 22:54:09.685 N/A IEEE 802.15.4 74 OxTff Beacon Request
9629 22:54:09.758 0x0| ZigBee 92 Beacon, Src: 0x0000, EPID: 00:00:00_09:87:6.
9630 22:54:09.785 0x1l  Set/Unset Time Reference 8T ZigBee 92 Beacon, Src: 0x1457, EPID: df:2e:ee:27:24:1
9631 22:54:09.835 Ox4l ZigBee 111 0x0000 Rejoin Request, Device: @x48f5
9633 22:54:10.194 Ox4! IEEE 802.15.4 76 0x0000 Data Request
9635 22:54:10.202 0xOI ZigBee 121 0x48fs Rejoin Response, New Address: 0x48f5
9637 22:54:10.445 oxay 1Me Shift.. oaeT IEEE 802.15.4 76 0x0000 Data Request
9630 22:54:10.694 ox4t Packet Comment... X &®C IEEE 802.15.4 76 ©x0000 Data Request
Delete All Packet Comments
» Frame 9665: 69 bytes on w ) on interface @
> Null/Loopback Configuration Profiles... 1 38A
» Internet Protocol Version
» User Datagram Protocol, § m ~
» ZigBee Encapsulation Prot [EmiEf & Sl sEeE
v IEEE 802.15.4 Ack, Sequence Number: 25

Vv Frame Control Field: 0x0002, Frame Type: Ack, Destination Addressing Mode: None, Frame Version: IEEE Std 802.15.4-2003, Source Addressing Mode: None
... .010 = Frame Type: Ack (0x2)

Security Enabled: False
Frame Pending: False

Acknowledge Request: False
PAN ID Compression: False

Conuance Mumbac Cusacaccions Ealea
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Marked packets will become highlighted, and can be exported with the File menu option -:
§  Wireshark Iig Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help O N 1 D 3 D o 00%ED Sat11:14 Q=

[ NON ] Open :{o] Loopback: 100 (udp port 17754)
= Open Recent »> e~
4 @ Fe=Haaal

Merge...

Apply a display filt ~ Import from Hex Dump... ~| Expression.. | + Leave = Association | Announce

No. Time Close BW Protocol Length Destination Info

Save #S IEEE 802.15. Beacon Request
Save As... ZigBee Beacon, Src: 0x0000, EPID: 00:00:00_09:87:65:43:21
ZigBee 2 Beacon, Src: 0x1457, EPID 27
" ZigBee 0x0000 Rejoin Request, Device: 0x48f5
Al S IEEE 802.15. Ack
i ZigBee OxFFff Command, Dst: Broadcast, Src: 0x1457
Export Specified Packets... IEgE 802.15. 0x0000 Data Request
Export Packet Dissections IEEE 802.15. 9 Ack
Export Packet Bytes... 08X ZigBee 0x48f5 Rejoin Response, New Address: 0x48f5
" IEEE 802.15. 9 Ack
Export PDUs to File... IEEE 802.15. 0x0000 Data Request
Export SSL Session Keys... IEEE 802.15. 9 Ack
H IEEE 802.15. 0x0000 Data Request
Export Objects et 5 I
. IEEE 802.15. Oxffff Beacon Request
Print... ZigBee 2 Beacon, Src: 0x0000, EPID:
0x1457 ZigBee 2 Beacon, Src: @x1457, EPID
0x48f5 ZigBee 0x0000 Rejoin Request, Device: 0x48f5 -
N/A IEEE 802.15. 9 Ack
0x48f5 IEEE 802.15. 0x0000 Data Request
N/A IEEE 802.15. Ack
0x0000 ZigBee 0x48f5 Rejoin Response, New Address: 8x48f5
on wire (552 bits), 69 bytes captured (552 bits) on interface @

Frame 9665: 69 bytes

Null/Loopback

Internet Protocol Version 4, Src: 127.0.0.1, Dst: 127.0.0.1

User Datagram Protocol, Src Port: 17754, Dst Port: 17754

ZigBee Encapsulation Protocol, Channel: 11, Length: 5

IEEE 802.15.4 Ack, Sequence Number: 25

v Frame Control Field: 0x@002, Frame Type: Ack, Destination Addressing Mode: None, Frame Version: IEEE Std 802.15.4-2003, Source Addressing Mode: None
. . .010 = Frame Type: Ack (@x2)

= Security Enabled: False

= Frame Pending: False

= Acknowledge Request: False

A4vVVVvVY

0000 02 00 00 00 45 00 00 41
7f 00 00 01 7f 00 @0 01 45 5a 45 5a 00 2d fe 40 EZEZ --@
45 58 02 01 @b 00 01 @0 ff df 73 7f 84 f9 db 22 EX H "
do 00 00 26 85 00 00 00 00 00 00 00 00 00 00 05 &
02 00 19 00 80

» O Z wireshark_l00_20181018211400_Znw1Cs.pcapng Packets: 11975 - Displayed: 11975 (100.0%) - Marked: 32 (0.3%) Profile: Default

The Export dialog provides an option to select the packet range to be exported - to export just the
required packets, select the Marked packets only option -:

[ BON ] M Wireshark - Export Specified Packets
Look in: % [Users 1< g Q| & [ E
B Computer Name Size Kind Date Modified v
~ . % chris -- Folder 14/10/2...8 10:12
a chris Shared -- Folder  19/01/2...8 19:58
Guest -- Folder 23/07/2...7 11:27
Save
File name:
Cancel
Export as:  Wireshark/tcpdump/... - pcap ﬁ Help
Packet Range Compress with gzip

Captured (@ Displayed

All packets 11975 11975
Selected packets only 1 1
© Marked packets only 32 32
First to last marked 32 32
Range: 0 0
Remove ignored packets 0 0

Note that in order to export the specified packets, live capture must be stopped.
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